HP Service Manager
for supported Windows® and UNIX® operating systems

Release Notes
Software version: 9.31.1008 Patch 1/ December 2012 (Updated June 21, 2013)
This document provides an overview of the changes made to HP Service Manager for the 9.31.1008 Patch 1
release. It contains important information not included in the manuals or online help.

Patch Release Strategy Change for Service Manager 9.3x
Over the last few years we have consistently received feedback from our customers that, while Service
Manager is a great feature-rich product, a number of quality issues remain. We are pleased to announce that
we have released just as many Service Manager patches over the last year as in the past, but with the
following significant differences:
• After only three quarters of 2012, we have already fixed 50% more defects in those patches than in the
entire of the last year.
• Over 60% of these fixed defects were on Service Manager 9.3x. We have dramatically enhanced our
testing procedures for SM 9.30 to find more defects than ever before. This has enabled us to proactively fix
these defects before customers can report them.
• We are not only fixing platform defects, but also releasing improvements to the applications, the
documentation and the upgrade process.
Initial customer feedback indicates that our new strategy is working. However, we know that fixing defects
is not enough to keep Service Manager ahead of our competitors. Our customers also want us to make
smaller enhancements to the product to improve usability and supportability at a far more rapid pace. To
that end, we are changing the patch release model for Service Manager 9.3x:
• We plan on creating a 9.3x minor-minor patch release (for example, SM 9.31, 9.32, and so on) every 6 to
9 months. These minor-minor releases will contain enhancements to functionality and new features.
• Once a new minor-minor patch is released, the build patches (for example, 9.30p5) on the previous
release will stop. After the SM9.31 release, there will be no further patches on SM9.30.
• We will continue to release build patches (for example, 9.31p1) on a regular basis between minor-minor
patch releases.
• Minor-minor patches can be adopted component by component. For example, if you only need the
platform updates, you do not need to do an applications upgrade. When the release is posted on HP Software
Support Online (SSO) portal, the components will be structured so that you can download only the parts you
require. The release notes will clearly indicate any dependencies if they exist.
There is no change in release strategy for older versions of Service Manager, such as SM9.21 and 7.11.
We hope this release strategy will meet your needs for a continued high-quality Service Manager on-premise
product.
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Documentation Updates
The first page of this release notes document contains the following identifying information:
•

Version number, which indicates the software version.

•

Publish date, which changes each time the document is updated.

To check for recent updates or to verify that you are using the most recent edition, visit the following URL:
http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.
You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HP sales representative for details.
Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To
download Adobe Acrobat Reader, go to the following web site:
http://www.adobe.com/
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In This Version
Hebrew Language Support
The SM9.31 Windows and web clients provide Hebrew language support, but cannot provide correct right-toleft display for text strings with mixed Hebrew and English characters. The SM9.31p1 (or later) web client
includes a number of important fixes for Hebrew language support, and is therefore strongly recommended.
For more information, see the Service Manager 9.30 Hebrew Language Pack Release Notes, available from
the HP Software Manuals Site at http://h20230.www2.hp.com/selfsolve/manuals.

New JavaScript Method
This release adds the following JavaScript method.

JavaScript method: SCFile.setBinary()
This method saves binary data to a field in a Service Manager file object.
Syntax
SCFile.setBinary (fieldName, binaryObj);

Arguments
Argument

Data type

Description

fieldName

String

The name of a field in which you want to save the
binary data.

binaryObj

String

The name of a JS object that contains the binary data.

Return values

RC_SUCCESS or one of the other global return code values. The method returns RC_SUCCESS if
the method successfully saves binary data to a Service Manager file object or returns one of the error
global return code values if the method cannot save binary data to a Service Manager file object.

Example
var rc;
var f = new SCFile("contacts");
rc = f.doSelect('contact.name#"AARON"');
var attachmentObj = f.getAttachments();
var b = new SCFile("blob1");
b.name = attachmentObj[0].name;
b.setBinary ("data",attachmentObj[0].value );
rc = b.doSave();
See QCCR1E79400.
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Fixes
This software release includes the following fixes.

Server
SCR

Problem

Fix

QCCR1E32056

Accessing a file with too high of a field
index causes a Signal 11 error. For
example, a statement such as 10000 in
$L.file will cause a signal 11.

No Signal 11 error will occur.

QCCR1E70720

When using a multi-level Advanced Filter
in a search form with the "Not" flag
checked, the generated query causes a
parsing error.

When using a multi-level Advanced Filter
in a search form with the "Not" flag
checked, the generated query will not
cause an error.
Known Issue: The OR operator is not
supported by Service Manager. For
example, the following queries are not
supported by SM:
file1_clause or file2_clause
not (file1_clause and file2_clause)

QCCR1E70833

A complex query that uses a condition for
an array field returns no record data.

The complex query will display results as
expected.

QCCR1E77310

When you associate an IM record to a PM
record, the following error message is
received:
"Target file variable two is not a

The fix for this behavior introduces the
following behaviors:
1

Application start-up parameter
variables (i.e., "$INTO.*") are no longer
overwritten by other applications
(especially RAD triggers) started by the
current application.

2

You no longer need to define a "$L.*"
local variable to cache start-up
parameters for later reuse. Now this
will be done automatically.
Note: There is no need to recompile
any RAD application to apply this fix.

relation (script.execute,
save.mods)".

QCCR1E78958

System-generated queries that contains "
OR (m1."NUMBER" IS NULL)" or a
similar syntax are slow to respond on
Oracle 11.

To avoid this issue, system-generated
queries will no longer contain " OR
(m1."NUMBER" IS NULL)" or similar
syntax.

QCCR1E79293

When a session receives a Signal 11 error,
the session hangs. Additionally, you
cannot terminate the session by using the
command "kill" in system status. The
session continues to consume CPU.

When a session receives a Signal 11 error,
the session will be terminated.
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SCR

Problem

Fix

QCCR1E79400

You cannot extract data from
SYSATTACHMENTS and manipulate the
binary data without corrupting the data.

A new JS function, setBinary, has been
introduced to save the binary data to a
table.

QCCR1E80243

A session terminates with a Signal 11
error, and you cannot to terminate the
session by using the "kill" command in
system status. Therefore, the session
continues to consume CPU.

By avoiding the unnecessary access when
the JavaScript Garbage Collector finalizes
an iterator, the Signal 11 error no longer
occurs.

QCCR1E84025

Service Manager crashes when executing
Knowledge Management multi-thread
concurrency tests.

The Knowledge Management plug-in can
now support multi-thread concurrency
operations as expected.

QCCR1E84106

A Signal 11 error is logged while trapped
in an endless recursion in the
libsm.so::pasymgetEx() function.

After a user logs out, the RTE code will no
longer try to access the global symbol table
after it has been freed.

QCCR1E84156

When you open, update, resolve, or close
an Incident, a warning message appears:
Warning, indexing to NULL. The
incident takes over 5 minutes to update.

This issue occurs because the old
implementation of the "copycurrent" RAD
function did not copy a merged file
properly. This has been fixed in this
solution.

QCCR1E84162

When running a load test with a Web
service implementation, the following
message is written to the SM log file many
times:
"Waiting for current response to be
consumed by the producer."
Note: The sessions that are connected
write these messages, while the ones that
successfully log out do not.

Now, there is a check to see whether a
session already timed out before a message
is written.

QCCR1E84496

The system navigator is not displayed after
login.

Now, users can log in as expected. The
system navigator is displayed correctly.

For more information, see New JavaScript
Method.

Web Tier
SCR

Problem

Fix

QCCR1E51535

The customized date separator is not
displayed when selecting a date from the
drop-down calendar.

The date separator (which should be "/", "-",
or ".") now can be displayed correctly in
date fields.
Note: The date separator is the separator
character used in the date format, such as
for separating the month, day, and year,
for example, mm-dd-yy. The / is the default
separator character. You can also use “-” or
“.” instead of the default separator.
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SCR

Problem

Fix

QCCR1E64004

If other records and/or attachments are open
in the same client, the user gets a 404 error
in the Web client when trying to open or view
the attachment(s) of one record.

The Web client now can retrieve and open
attachments in a record whether or not
other records and/or attachments are open
in the same client.

QCCR1E64210

When the user attempts to log in to a
Japanese Web client with a wrong username
or has exceeded the Max Logins value, the
error message displayed on the user's login
page is not recognizable.

The error messages now display correctly
in Japanese on the user's login page.

QCCR1E64432

Help text is not displayed against read-only
multi-line text fields.

Help text is displayed for all read-only
fields.

QCCR1E74130

The following Internet Explorer warning
message still appears in the Web tier.
"This page contains secure and non-

Note: For the HTML Editor, use Alt+F1 to
view Help on Field in the web client. After
closing the pop-up help of an HTML Editor
field, you need to press Tab in Internet
Explorer or Shift+Tab in Firefox to move
the focus back to the text input area of the
HTML Editor.
The warning message now no longer
appears.

secure items. Do you want to display
non-secure items?"

QCCR1E76628

When a form is refreshed, the cursor is
returned to the first tab regardless of its
initial position.

Now, when the user selects a tab on the
client side, the notebook state is saved and
is then restored when the form is
refreshed.

QCCR1E78383

In Internet Explorer, the Status bubble in
the SLA section of the Incident module is
larger than normal. This issue does not occur
in Firefox or in the Windows client.

The Status bubble icon now displays
normally in Internet Explorer.

QCCR1E78690

JAWS loses focus, and the user cannot
manually select the link options by using the
keyboard after the user has entered the Fill
Field section.

Once the page is loaded, the first record in
the list is selected. The user can press the
TAB key to change the focus and can press
ENTER to select the row that has received
the focus.

QCCR1E78734

Us.print does not function correctly when
called from a display option in the Web
client. Instead, a "Loading" message appears
briefly and then nothing more occurs. When
called from the Windows client, the print
dialog is displayed as expected.

Now, the print window is displayed as
expected when us.print is called.

QCCR1E79906

A security warning for the mixed
content appears in Internet Explorer when
accessing a retired document in Knowledge
Management.

The warning message now no longer
appears.
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SCR

Problem

Fix

QCCR1E80094

After you log in to a Web tier instance that
uses SSL, the following security warning
message appears when you click the Cancel
button under the list of document types
under Contribute Knowledge in
Knowledge Management:
"This page contains both secure and

The warning message now no longer
appears.

nonsecure items. Do you want to display
the nonsecure items?"

QCCR1E80162

After logging in through the Web tier under
SSL and then cancelling the registration of
new interactions in the Service Desk module,
the following Internet Explorer security
message is received:
"This page contains both secure and
nonsecure items".

The warning message now no longer
appears.

QCCR1E80153

After logging in through the Web tier under
SSL and then changing the interactions in
Service Desk > Interaction Queue several
times, the following Internet
Explorer security message appears:
"This page contains both secure and
nonsecure items".

The warning message now no longer
appears.

QCCR1E83916

The Change workflows in the Web tier
display an incorrect last modified time. The
time displayed is correct, but the date is
incorrect.

The last modified time displays the correct
date and time in the Web tier.

QCCR1E84453

In Forms Designer, if a Table Column
control's input contains IE reserved
keywords, such as "default", "return", etc, it
will cause an exception in the web tier. As a
result, the user will see a blank record page.

No matter whether a Table Column
control's input contains IE reserved
keywords or not, the user will see the
correct record page.

QCCR1E84455

When clicking the Line Items button on the
toolbar of a Quote record, its associated line
items do not appear in the list pane.

The associated line items now appear in
the list pane.

QCCR1E84584

Users cannot print Knowledge Library lists
or entries from the Web client in Service
Manager 9.30 patch releases 4 and 5.
Instead, the HTML code is displayed, which
makes the record unreadable.

Users can successfully print Knowledge
Library lists or entries.
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SCR

Problem

Fix

QCCR1E84608

When a record contains special characters in
a multi-line text field, the Web client
converts the characters to their HTML code
representations in print preview. For
example, quotation marks are replaced by
&quot, a greater than sign (>) is replaced by
&gt, and so on. Because of this behavior, the
prints are garbled and difficult to read.

Print preview now displays all characters
correctly.
Limitations:

QCCR1E84711

• In single-line text fields, some nonprintable characters will display as their
encoded string (such as "&#x1a;").

Users cannot open an existing conversation
created by OMi.

The existing conversation created by OMi
opens.

In the ESS client, a 404 error occurs when
the user attempts to open an attachment.

In the ESS client, now the user can open
an attachment successfully without any
errors.

This issue occurs in the following scenario:
Both Service Manager and OMi are
integrated with Enterprise Collaboration
(EC).
The OMi-SM integration has been set up so
that events can be forwarded to Service
Manager as Incidents.
When a user creates a conversation for an
event in OMi, opens the corresponding
Incident in Service Manager, and then clicks
the Open Conversation button, a dialog
displays, incorrectly asking if the user wants
to create a new conversation. Instead, users
expect that the existing conversation created
by OMi opens.
QCCR1E88461

• In single-line text fields, the string
"]]>" will be encoded as "&#93;&#93;&gt;".

Windows Client
SCR

Problem

Fix

QCCR1E76628

When a form is refreshed, the cursor is
returned to the first tab regardless of its
initial position.

Now, when the user selects a tab on the
client side, the notebook state is saved and
is then restored when the form is
refreshed.

QCCR1E83993

The last Thai character is replaced by a
question mark on the SM Windows client.

By fixing the encoding logic, the last Thai
character now can be displayed correctly.
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Applications
SCR

Problem

Fix

QCCR1E84323

In the SM9.30P4 and SM9.30P5 Knowledge
Management patches, the
QCCR1E67750_SM930P4_SM930.unl unload
files differ in content.
The QCCR1E67750_SM930P4_SM930.unl
file, which is delivered with "sm9.30.511P5_KM" is missing the display option with
default 'Clear' label.

Added the missing display option to make
the unload file consistent in the different
patches.

In SM9.30p1, the updated unload is named
QCCR1E67750_SM930P4_SM930.unl.

Mobility Client
SCR

Problem

Fix

QCCR1E74351

When closing an Incident in the Mobility
client, users cannot select a Closure Code
because no closure codes are displayed.

The Closure Code list is now displayed
when users close an incident.

Documentation
SCR

Problem

Fix

QCCR1E88514

The support matrix documents for SM9.30
and SM9.31 need to be updated to state that
starting with version 9.30p5 Service
Manager requires Oracle Call Interface (OCI)
11.2.0.3 (OCI 11.2.0.1 and 11.2.0.2 are not
supported).

Updated the Service Manager 9.30 and
9.31 support matrix documents. The
updated documents are available from the
HP Support Matrices portal:
http://support.openview.hp.com/sc/support_
matrices.jsp

As of version 9.30p5, Service Manager has
introduced a performance improvement for
data retrieval from CLOB fields. Due to an
issue with OCI 11.2.0.1 and 11.2.0.2, this
improvement requires OCI 11.2.0.3 or later.
The support matrix documents were not
updated to include this information.
Note: This issue affects only the following
SM versions: SM9.30p5, SM9.31 and later.
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Known Problems, Limitations, and Workarounds
This software release has the following known issues and limitations.
Note: The following is a cumulative list of known issues and limitations in the Service Manager 9.31p1
server, Windows and web clients, and the Mobility client. It includes those that already exist in previous
releases (Service Manager 9.30 GA and patches, and 9.31).

Platform (Server, Windows Client, and Web Client)
SCR

Problem

Workaround

Service Manager 9.31
QCCR1E78426

QCCR1E78840

In Internet Explorer 7 and 8, users may see a
warning from their web browser when
exporting a list to a text file:
To help protect your security,
Internet Explorer blocked this site
from downloading files to your
computer. Click here for options...
When users click Download File, the
following message may display:
To display the webpage again, the
web browser needs to resend the
information you've previously
submitted.
If you were making a purchase, you
should click Cancel to avoid a
duplicate transaction. Otherwise
Retry to display the webpage again.
When users click Retry, the following
message may display:
The Service Manager main
application is already open in
another browser tab. Please go to
that page to save your work, and
then continue.
When users click Continue, the file
downloading works correctly.
You cannot start Service Manager (SM) if the
parent directory in which SM is installed
contains a special character, such as the
following: % @ &.

There are several ways to work around this
issue.
•
On the export to text screen, hold
down the Ctrl key when clicking the OK
button until the file download dialog pops
up.
•
Add the host of the web server or web
application server to the trusted sites, and
configure IE security settings to enable the
option Automatic prompting for file
downloads for trusted sites (Security tab
> Custom Level).
• Enable this feature by utilizing the
security policy or through a security
feature control registry key. For more
information, see
http://msdn.microsoft.com/enus/library/dd565669%28v=vs.85%29.aspx

To work around this issue, do not install
SM in a directory that contains special
characters.

Note: This behavior occurs when you are
using LW-SSO. The issue occurs because the
LW-SSO implementation in a third-party
product used in SM cannot correctly read a
directory that contains these characters.
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SCR

Problem

Workaround

QCCR1E75711

The vertical scroll bar on a sub-form in the
Web client does not appear. Instead, it
overlaps the other fields.

If a subform contains only a table, make
sure that the table and subform have the
same height. This way, a vertical scroll bar
will appear for the table if needed when the
total height of all table rows exceeds the
specified table height. If you specify a table
height greater than the subform height,
the table rows may overflow outside the
subform and overlap other fields on the
form. If a subform contains multiple
widgets, make sure that the subform
height is set to be large enough to hold all
the widgets; otherwise overlaps may also
occur.

QCCR1E80257

In Internet Explorer 7, the focus is
incorrectly set on the htmleditor when it
should be set on another field.

No workaround at this time.

QCCR1E69176

When you run "sm -shutdown -group"
directly on the SM Server, the smservice does
not stop.

Stop the Windows service or run a net stop
command (for example, C:\Program
Files\HP\Service Manager
9.30\Server\RUN>net stop "HP Service
Manager 9.30 Server").

Service Manager 9.30 or 9.30 patches
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SCR

Problem

Workaround

QCCR1E88514

In SM 9.30 P5, 9.31or later, sometimes
CLOB fields will not have their data fetched
from the database into RTE.
This issue occurs when OCI client library
11.0.2.1 or 11.0.2.2 is used.

Upgrade the OCI client library to 11.0.2.3
or later.
Note: The Service Manager 9.30 and 9.31
Support Matrix documents have been
updated to state that SM9.30p5/ SM9.31 or
later does not support OCI client library
versions 11.0.2.1 and 11.0.2.2.
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SCR

Problem

Workaround

QCCR1E72337

CI icons cannot be displayed in CI
visualization if the SM Web tier is deployed
in an Application Server with "httpOnly"
enabled (for example, Tomcat 7).
The HttpOnly attribute directs browsers to
use cookies via the HTTP protocol only. An
HttpOnly cookie is not accessible via nonHTTP methods, such as calls via JavaScript.

This issue has been fixed in Java SE
Version 7 Update 6 (7u6) and later. Install
the latest JRE (7u6 and above) on the
machine that runs Internet Explorer. CI
icons will then be displayed correctly.
Note: Due to a known issue in JDK (bug
id: 7196513), CI icons will not be displayed
in Firefox when httpOnly cookies are
enabled.

QCCR1E28000

If the Equal sign (=) is the first character in
an array field, it will be truncated.
When Service Manager is running on Unix,
the legacy listener may log intermittent
signal 11 upon CIT initial connectivity test if
exec-shield is not set properly.

No workaround is available at this time.

QCCR1E57385

Use the workarounds to solve this issue.
Solution 1:
Connect Connect-It to the Web Services
connector instead of the Legacy Listener
connector.
Solution 2:
Before connecting Connect-It to the Legacy
Listener connector, do the following:
1

Add usethreading:0 in the sc.ini file,
which is located in <Service Manager
server installation
path>\LegacyIntegration\RUN.
Note: For 64-bit RedHat Linux servers
only, you can alternatively run the
following shell commands as root:
# sysctl -w kernel.exec-shield=0
# sysctl -w
kernel.randomize_va_space=0

2
QCCR1E32086

A Knowledge document with attachments
can have hypertext links to those
attachments. When a user needs to update
an attachment, the user may double-click the
attachment to open it from within the
knowledge document edit format, update the
attachment, and then save it. This will result
in a broken link to the file attachment

QCCR1E59371

In the web client, when a QBE form is
displayed as the result of a Fill operation,
many tab operations are required to position
the cursor on the list to select from when
using Internet Explorer, while only one tab
operation is required when using Firefox.

Start the legacy listener.

When a user needs to update an
attachment, the document needs to be sent
into the Knowledge Management workflow
so that administrators can edit the
document, view the attachment, and then
save the attachment to the desktop to
make changes to the attachment. Once the
attachment is updated, re-upload the
attachment to the knowledge document, relink to the attachment, and then re-publish
the document.
No workaround available at this time.
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SCR

Problem

Workaround

QCCR1E63548

On an android phone, the username and
password labels in the log-in screen are
inside the text field.
When creating a new workflow using Process
Designer for the first time or after clearing
the browser cache, the workflow canvas will
be blank and not display an initial starting
node.

No workaround available at this time.

QCCR1E64268

QCCR1E64377

QCCR1E65527

In the web client, when you open a
Configuration Item (CI) record, the CI label
does not show (or only shows for the first
time) in the CI Visualization (Relationship
Graph).
Some lines on the SM Client Uninstall
Feature Selection dialog are not fully
displayed

There are two ways to work around this
issue:
1

Load an existing workflow first. After
that, creation of a new workflow for the
first time will work properly.

2

Attempt to create a new workflow
again. The second attempt to create a
new workflow for the first time (or
after a browser cache flush) will
succeed.

No workaround available at this time.

Run the SM Client uninstaller from the
command line, using the -console option, as
follows:
1

Open a cmd shell and change to the
Client\_uninst subdirectory of the
ServiceManager install folder.

2

Run "uninstaller -console" in this folder

3

Follow all prompts

Note: Repeated install/uninstall cycles can
cause the uninstaller to be installed into
the folder "_uninst2" instead.
If this happens, then use this folder, and
its uninstaller.exe instead.

Mobility Client
SCR

Problem

Workaround

QCCR1E84298

In the Mobility Client, if a user closes an
Incident and then opens the list of Incidents
assigned to the user, the closed Incident still
shows up in the list.

When opening the list of incidents assigned
to you, remember to click the 'Refresh'
button in the upper right corner, so that
closed incidents will disappear from the
list.

Documentation Errata
The following items are listed incorrectly in the SM9.31 documentation.
15

Web parameter AppServerEncoding should be removed
LOCATION:

Topics in online help, “What’s new in HP Service Manager 9.31?, “Web parameter:
AppServerEncoding”, and “Client parameters for Web clients”.

ERROR:

This parameter is not yet implemented in the SM9.31 or SM9.31p1 web client, and
hence should not have been documented.

CORRECTION:

This parameter should be removed from the SM9.31 online help.

JavaScript method SCFile.getBinary() is incorrectly documented
LOCATION:

Programming Guide: “JavaScript function: getBinary”

ERROR:

This should be documented as a JavaScript method for JavaScript object SCFile.

CORRECTION:

See the following for the correct documentation:

JavaScript method: SCFile.getBinary()
This JavaScript method returns the binary representation of a field in a Service
Manager file object.
Syntax
SCFile.getBinary (fieldName);

Arguments
Argument

Data type

Description

fieldName

String

This argument specifies the name of a
field from which you want to extract the
binary data.

Return values

The method returns a JS object that contains the binary data of the field.
Example
var bb = new SCFile("bbtosysattachments");
var rc = bb.doSelect("true");
var attachmentObj= new Attachment();
attachmentObj.value = bb.getBinary("att_attachment")
attachmentObj.name = bb.att_filename;
attachmentObj.type = "excel";
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Back-out Instructions
If you want to restore your Service Manager system to its original state after installing Service Manager
9.31, follow these guidelines.

Server
Before applying the server patch, make a backup of the server installation folder. For example, C:\Program
Files\HP\Service Manager 9.30\Server.
To roll back your server to its original state, remove the existing server installation folder and copy the old
one back.

Applications
Before loading an unload file, perform the following steps to make a backup of the files to be modified by the
unload file:
1

Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to
the unload file.

2

Click List Contents on the menu bar, to view a list of files that have been updated in this unload.

3

Go to Tailoring > RAD Editor, search for the files you got in step 2, and click More > Export/Unload.

4

In the popup window, specify your backup upload file path/name, and click Unload Appl. Note: Make
sure that Append to file is selected.

Web Tier
Before deploying the new web tier, back up your web.xml file, application-context.xml, splash screen,
style sheets, and any other customizations you made, including your webtier-9.30.war (webtier-ear9.30.ear) file.
To roll back to the old web tier:
1

Delete or uninstall the existing web tier.

2

Redeploy the old web tier.

3

Restore your old customizations.

Windows Client
You can only uninstall the new Windows client, and then reinstall the old version.

Installation Notes
Digital signature notice
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HP signs Windows executable files with a digital signature. Since SM 9.30.p3, this process has been updated
to use a new VeriSign root certificate. On a Windows system that does not have the new VeriSign root or
intermediate certificate installed, when the user right-clicks the file and then goes to Properties > Digital
Signatures > Details, a verification error will display: “The certificate in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as
documented at: https://knowledge.verisign.com/support/ssl-certificatessupport/index?page=content&actp=CROSSLINK&id=SO19140

Web Tier Installation
The Web Tier update consists of a compressed file, sm9.31.1008-P1_Web_Tier.zip. The specific upgrade
process depends on your particular Web application server, but follows the same steps as deploying a new
installation.
The Service Manager Web Tier contains a J2EE-compliant web application that runs on your web
application server. Each web application server has its own method of deploying web applications. See your
web application server documentation for specific instructions on deploying a web application.
The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must
save your customized files and replace the new version of these files with your customized version. For more
information, refer to the Service Manager Interactive Installation Guide.
Note on Tomcat 7.0: If you plan to deploy the web tier on Tomcat 7.0 using the Tomcat Manager, be sure to
set the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat
7.0_Home>webapps\manager\WEB-INF\web.xml to an appropriate value greater than the web tier .war
file size; otherwise the deployment request will be rejected because the web tier .war file exceeds the default
maximum values. This restriction does not exist in Tomcat 6.0.
1

Back up your web.xml file, application-context.xml file, splash screen, style sheets, and any other
customizations you made, including your webtier-x.xx.war (webtier-ear-x.xx.ear) file.
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2

Delete or uninstall the existing .war or .ear file.

3

Deploy the new webtier-9.31.war (webtier-ear-9.31.ear)) file by following the instructions in
the Service Manager 9.30 Interactive Installation Guide.
Note: HP recommends that you deploy with a unique context root, for example /webtier-9.31.1008.

4

Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to ensure
that any new parameters are properly merged into the files used in your final deployment. Do this for
application-context.xml as well as any other files you may have customized (such as style sheets
and splash screens).

5

Make any new customizations necessary for your deployment.

6

Restart the Application server.
Note: Before accessing the new Web Tier, HP recommends that all users empty their browser cache.

Windows Client Installation
The Windows client update consists of a compressed file, sm9.31.1008-P1_Windows_Client.zip, which
contains the executable installation files.
To install the Windows client update:
1

Stop the Service Manager Windows client.

2

Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.)

3

Run setup.exe and install the client by following the instructions in the Service Manager 9.30
Interactive Installation guide.

4

Check the version in Help > About Service Manager Client.
The client should be Release: 9.31.1008.

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.31.1008P1_<OS>.zip
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the
[SM Server Root]\ ([SM Server Root]/) RUN, irlang, legacyintegration, and
platform_unloads directories.
Note: If you have a horizontally scaled system, you must upgrade all server instances.

Upgrade Paths
This server patch must be applied on top of one of the following versions/patch levels of the SM server:
•

SM9.30 GA

•

SM9.30 Patch/Hotfix

•

SM9.31

The following server upgrade paths are recommended:
•

New customers: Install the SM9.30 GA server, and then directly apply the latest 9.31 server patch;
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•

Existing SC6.2, SM7.11 and 9.21 customers: Uninstall the old server, install the SM9.30 GA server, and
then apply the latest 9.31 server patch;

•

Existing SM9.30 and 9.31 customers: Apply the latest 9.31 server patch.

For installation instructions of the SM9.30 GA server, see the Service Manager 9.30 Interactive Installation
Guide, which is available from the HP Software Manuals Site:
http://h20230.www2.hp.com/selfsolve/manuals
For installation instructions of the server patch, see the following.

Server Patch Installation Steps
Important: This server update will upgrade the embedded Tomcat to version 6.0.35. It will also update the
schemastub.xml file (\RUN\km\styles\schemastub.xml), which contains changes required for the KM Solr
search engine. In addition, your server’s lwssofmconf.xml file will also be updated.
To install the Server update:
1

Stop all Service Manager clients.

2

Stop the Service Manager server.

3

Make a backup of the RUN directory.

4

Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.35 when you
extract the server files later.

5

Delete the RUN/lib directory.

6

Extract the compressed files for your operating system into the main Service Manager directory on the
server. The default path is: C:\Program Files\HP\Service Manager 9.30\Server.

7

For UNIX servers, set the file permissions for all Service Manager files to 755.

8
9

If you have made any customizations/changes to the original RUN/tomcat folder, restore them in the new

RUN/tomcat folder.

Your server’s old lwssofmconf.xml file has been overwritten. If you have configured LW-SSO in the old
file, merge the parameter settings in the old file from your backup of the RUN directory into the new
lwssofmconf.xml file.

10 If you were running a server earlier than version 9.31, your old schemastub.xml file (in the
<SM_Server_Home>\RUN\km\styles\ directory) has been updated to a new version. If you want to use the
new KM Solr search engine features, follow the steps described in the Solr Search Engine Update
Installation section; otherwise, copy your old schemastub.xml file back.
Note: The schemastub.xml file is same with the one released with SM9.31.
11 Make sure the server is stopped, and run the "sm -unlockdatabase" command.
The purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.
Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required whenever you
change the server’s IP address after your upgrade to 9.30p4 or later.
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12 Restart the Service Manager server.
13 Restart the Service Manager clients.
14 Check the version in Help > About Service Manager Server.
The server should be Release: 9.31.1008.

Application Unload Installation
Important: Unlike in Service Manager 9.30 patch 5 or earlier, all unload files in the server’s
platform_unloads directory in this release have been already merged into the Service Manager 9.31
applications. These files are provided just in case you do not plan to upgrade to applications 9.31 while still
want to take advantage of the relevant new features/fixes.
When you extract sm9.31.1008-P1_<OS>.zip (or .tar), the unload files included in this release are added
to your [SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads) directory.
An unload file is provided when a platform fix (in most cases, a server fix) in a platform patch also requires
an applications change to resolve an issue. Unload files introduced in earlier patches are also included in
each cumulative patch release. If you have not already applied them for a previous patch, you should also
apply those that are intended for your applications version. For more details about these applications
updates, see the Release Notes for those patches.
Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 should be
applied first, then those introduced in patch 2, and so on. However, unload files introduced in the same
patch normally can be installed in a random order (there might be occasional exceptions).

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:
• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example,
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any).
• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example,
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 and
should be used for patch 2 or later.
Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or later.
• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711,
which means the unload file is intended only for Service Manager applications version 7.11.
Note: If the applications version suffix is omitted, the unload file is then intended for all applications
versions compatible with the server version, unless otherwise specified. For example,
QCCR1Exxxx_SM930P4.unl is intended for applications versions 7.11, 9.20, and 9.30 (which are
compatible with Service Manager server 9.30), unless otherwise specified in the unload file description.
For information on the applicable applications versions for each unload file included in the current
patch, see Unload Files Included in the Current Patch.

Unload Files Included in the Current Patch
The following are unload files included in the current patch release.
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Unload file

Introduced
in

Used for
apps
version(s)

Description

QCCR1E76227_SM930P6_SM930.
unl

9.31

9.30

Contains the code changes to support
localization of incident/change priority
and urgency strings for the Mobility
Client.

QCCR1E78794_SM930P6_SM930.
unl

9.31

9.30

Removes incident.assignee when a Web
Service call specifies the assignee as
'NULL' via the Mobility Client.

QCCR1E76796_SM930P6_SM930.
unl

9.31

9.30

Provides the ability to turn on debugging
dynamically for user sessions or
schedulers.
Note: This unload requires the SM9.31
server.

QCCR1E71099_SM930P5_SM711.
unl

9.30p5

7.11

Displays Value Lists instead of the data
directly retrieved from the database in a
QBE list when adding a field by using
Modify Columns.

QCCR1E71099_SM930P5_SM920.
unl

9.30p5

9.20

Associated server fix: QCCR1E71099
(see the 9.30p5 Release Notes)

QCCR1E71099_SM930P5_SM930.
unl

9.30p5

9.30

Displays Value Lists instead of the data
directly retrieved from the database in a
QBE list when adding a field by using
Modify Columns.
Associated server fix: QCCR1E71099
(see the 9.30p5 Release Notes)

QCCR1E71139_SM930P5_SM930.
unl

9.30p5

9.30

Works with server fix QCCR1E71139 to
solve this issue: When Service Manager
is configured to use LDAP as the
authentication data source, the user is
still forced to change the password if the
user is expired in the local database.

QCCR1E31941_SM930P4_SM930.
unl

9.30P4

9.30

Enables users to use a pre-configured
decimal symbol when completing
numeric fields. See QCCR1E31941.
Notes:

This enhancement requires a 9.30p4 or
later server; however if you are using
RTE version 9.30 with applications
version 7.11 or 9.20, do not load this
unload file; you can safely upgrade your
server to 9.30p4 or later without
applying this applications change.
Associated server fix: QCCR1E31941.
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Unload file

Introduced
in

Used for
apps
version(s)

Description

QCCR1E73452_SM930P4.unl

9.30P4

7.11 - 9.30

Enables Mandanten restricting queries
to be updated correctly after a profile is
edited.
Associated server fix: QCCR1E71897.

QCCR1E67072_SM930P4_SM930.
unl

9.30P3

7.11 and
9.20

Enables users to take advantage of the
new KMStatusListener background
process.
Note: This unload file is not needed for
applications version 9.30 or later, which
supports only the Solr Search Engine.
Associated server fix: QCCR1E67071.

QCCR1E70163_SM930P4_SM711.
unl

9.30P3

7.11

Fixes the issue that the KMUpdate
process terminates abnormally.
Associated server fix: QCCR1E69687.

QCCR1E70163_SM930P4_SM920.
unl

9.30P3

9.20

Fixes the issue that the KMUpdate
process terminates abnormally.
Associated server fix: QCCR1E69687.

QCCR1E70163_SM930P4_SM930.
unl

9.30P3

9.30

Fixes the issue that the KMUpdate
process terminates abnormally.

QCCR1E67647_SM930P3.unl

9.30P3

7.11 - 9.30

Updates the exception message that
occurs in the request response when
closing an interaction by calling
CloseInteraction from a web service
without specifying the localSolution field
in the request.
Associated server fix: QCCR1E54192.

QCCR1E67610_SM930P2.unl

9.30P2

7.11 - 9.30

Enables you to block potentially
dangerous attachments.
Associated server fix: QCCR1E64290.

Associated server fix: QCCR1E69687.

To load an unload file:
1

Select either client or server-side unload, depending on the location of the unload files.
a

From the Windows client, go to Window > Preferences > HP Service Manager.

b

Flag Client-Side Load/Unload if the files are on the client machine, and clear the flag if they are
on the server.

c

Restart the Windows client if you changed the setting.

2

Open Tailoring > Database Manager.

3

Right-click the form or open the options menu and select Import/Load.

4

Fill in the following fields.
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Field

Description

File Name

Type the name and path of the file to load.

Import Descriptor

Since unload files do not require an Import Descriptor record, leave this field
blank.

File Type

Select the source operating system of the unload file.

Messages Option —
All Messages

Select this option to see all messages that Service Manager generates loading the
file.

Messages Option —
Totals Only

Select this option to see only the total number of files Service Manager loads.

Messages Option —
None

Select this option to hide all messages that Service Manager generates when
loading the file.

Note: You can view the contents of an unload file before importing it by clicking List Contents.
5

Click Load FG.

Knowledge Management Update Installation
Note: The Knowledge Management package in this release is the same with the SM9.31 KM package, except
that the QCCR1E67750_SM930P5_SM930.unl file has been replaced with
QCCR1E67750_SM930P4_SM930.unl to solve the problem described in QCCR1E84323.

KM Search Engine Update Installation
Follow the same steps as described in the KM Solr Search Engine Update Installation section in the SM9.31
Release Notes, but load QCCR1E67750_SM930P4_SM930.unl instead of
QCCR1E67750_SM930P5_SM930.unl.
Note: If you have already installed the SM9.31 KM package, you only need to load
QCCR1E67750_SM930P4_SM930.unl shipped with this release.

KM Import Utility Installation
Note: The km-import-9.31.zip file included in this release in same with the Import Utility .zip file in the
SM9.30p4, SM9.30p5, and SM9.31 releases.
Extract km-import-9.31.zip in the Knowledge Management package to a local drive. For detailed
instructions on the use of the import utility, see the README file packaged in this .zip file.

Mobile Applications Update Installation
The Mobile Applications package (sm9.31.1008-P1_Mobility.zip) contains an updated version of the
mobileItsmWebApp.war file that includes several fixes.
To install the Mobile Applications update:
1

Install Service Manager Mobile Applications version 1.0 shipped with the Service Manager 9.30 DVD, if
you have not already done so. For detailed instructions, see the HP Service Manager 9.31 Mobile
Applications User Guide.
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2

Make sure that the Apache Tomcat SMmobility Windows service or the Mobile Applications Tomcat
server is stopped.

3

If you have already configured Mobile Applications version 1.0 on your system before installing this
patch, make a backup of the following folder by renaming it:
<SM_Mobility>\Tomcat\webapps\mobileItsmWebApp
For example, rename it to mobileItsmWebApp_old.

4

Copy the mobileItsmWebApp.war file packaged in the sm9.31.1008-P1_Mobility.zip file to the following
folder to overwrite the old file: <SM_Mobility>\Tomcat\webapps\

5

If you have already configured Mobile Applications before installing this patch, restore your
customizations by copying your old AppConfig.groovy and CustomConfig.groovy files back to overwrite
the configuration files in the new mobileItsmWebApp.war file.
Note: Unlike in SM9.31, in this release you no longer need to manually add the
itsm.PageMaxRecords=10 parameter to the end of the CustomConfig.groovy file. Out-of-the-box, this
parameter is present and set to 10. You can change this setting if you want. This parameter defines the
maximum number of records that can be displayed on each page of the following types of lists:
— Home page: the Incident (Awaiting My Approval, and Assigned to My Groups), and Change
(Awaiting My Approval, and Assigned to My Groups) lists
— Incident Detail page: Status, Activities, Assignee, and Group lists
— Change Detail page: Activities, Group, Approvals, and Tasks lists

6

If needed, in the restored CustomConfig.groovy file, continue to configure language and dateFormat
settings (supported only in this Mobility patch). For details, see the SM9.31 Mobile Applications user
guide.

7

If you have not yet configured Mobile Applications before installing this patch, configure the Mobile
Applications by following the instructions in the SM9.31 Mobile Applications user guide. In this case,
you use the new CustomConfig.groovy file, which already contains the itsm.PageMaxRecords
parameter.

8

In <SM_Mobility>\Tomcat\conf\server.xml, add the URIEncoding="UTF-8" attribute for the HTTP
connector as shown below:
<Connector port="8080" protocol="HTTP/1.1"
connectionTimeout="120000"
redirectPort="8443" URIEncoding="UTF-8" />

9

Start the Apache Tomcat SMmobility Windows service or start the Mobile Applications Tomcat server.
The following new folder is created: <SM_Mobility>\Tomcat\webapps\mobileItsmWebApp

ODBC Driver Update Installation
Note: This release does not contain the ODBC .zip file that has been shipped with the SM9.30p4, SM930p5,
and SM931 releases.
You can download the zip file from http://support.openview.hp.com/selfsolve/document/KM00207925.
The ODBC Driver update contains the following updated files:
•

Scodbc32.dll

•

sci18n.dll

•

sccl32.dll
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To install the ODBC Driver update:
1

Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine
Systems\ServiceCenter 6.2\ODBC Driver.

2

When prompted, replace the three old DLL files with the new ones.

Verified Environments
The Support Matrix lists supported versions of operating systems, browsers, HP Software products, and
other compatibility and support information.
To access the Support Matrix:
1

Use a browser to navigate to the Software Support Online (SSO) web page:
http://support.openview.hp.com/sc/support_matrices.jsp

2

Log on with your Customer ID and password or your HP Passport sign-in.

3

Navigate to the applicable information.

Support
You can visit the HP Software support web site at:
www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP
Software offers.
HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient
way to access interactive technical support tools needed to manage your business. As a valued support
customer, you can benefit by using the support site to:
•

Search for knowledge documents of interest

•

Submit and track support cases and enhancement requests

•

Download software patches

•

Manage support contracts

•

Look up HP support contacts

•

Review information about available services

•

Enter into discussions with other software customers

•

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require
an active support contract. To find more information about support access levels, go to the following URL:
http://h20230.www2.hp.com/new_access_levels.jsp
To register for an HP Passport ID, go to the following URL:
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http://h20229.www2.hp.com/passport-registration.html
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Legal Notices
© Copyright 1994-2012 Hewlett-Packard Development Company, L.P.
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard
commercial license.
The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an additional
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
The information contained herein is subject to change without notice.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright © Jive Software,
1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino software Copyright © 1998-2004
The Mozilla Organization. This product includes software developed by the OpenSSL Project for use in the
OpenSSL toolkit. (http:// www.openssl.org). OpenSSL software copyright 1998-2005 The OpenSSL Project.
All rights reserved. This project includes software developed by the MX4J project
(http://mx4j.sourceforge.net). MX4J software copyright © 2001-2004 MX4J Team. All rights reserved.
JFreeChart software © 2000-2004, Object Refinery Limited. All rights reserved. JDOM software copyright ©
2000 Brett McLaughlin, Jason Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory
SDK Copyright © 1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis
Technology Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 Thomas
Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object Technology, Inc. and is
protected by US and international copyright law. Crystal Reports Pro and Crystal RTE software © 2001
Crystal Decisions, Inc., All rights reserved. Eclipse software © Copyright 2000, 2004 IBM Corporation and
others. All rights reserved. Copyright 2001-2004 Kiran Kaja and Robert A. van Engelen, Genivia Inc. All
rights reserved. Xtree copyright 2004 Emil A. Eklund. This product includes software developed by the
Indiana University Extreme! Lab (<http:// www.extreme.indiana.edu/>). Portions copyright © Daniel G.
Hyans, 1998. cbg.editor Eclipse plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in
this product is gSOAP software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van
Engelen, Genivia Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved.
Distributed under the Terms of Use in http:// www.unicode.org/ copyright.html.
Java is a registered trademark of Oracle and/or its affiliates.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.
UNIX® is a registered trademark of The Open Group.
For a complete list of open source and third party acknowledgements, visit the HP Software Support Online
web site and search for the product manual called HP Service Manager Open Source and Third Party
License Agreements.
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